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1. Introduction 
Once you have made a light measurement with a Viso measurement system you can 
use Light Inspector to generate a variety of PDF reports. The system contains both 
standard reports and customizable reports. 

1.1. Standard PDF report designs 
When you install Viso Light Inspector software, a variety of different PDF templates 
are available: 

  

The included reports are all locked in the sense, that you can use them straight 
ahead for making reports, but you cannot overwrite them.  

If you want to change or add something, just click the edit button, and you will be 
prompted to rename. 

   .vrep – edit in Viso Report Designer  
These are customizable standard reports that you can make your own version 
of. These reports will work even if you do not have Microsoft Office installed. 
These are reports that you can use as they are or change them as you wish 
with the built in Viso vrep editor 

  . docx or .rtf – edit in Microsoft Word 
These are reports that you can use as they are or change them as you wish 
with Microsoft Word.  

 If you have used a Viso system for many years, you will find replacements for 
the former “FIXED” reports in the “Lagacy template folder”. 

1.2. Your PDF report design 
Viso Light Inspector makes it possible for you to make your PDF reports look exactly 
how you want: 

 Your own language, logo, fonts and corporate visual identity 

 Your own selection of data and graphics 



 

 

 
4  

 

 Your own content: Photos, illustrations, special calculations and graphs via 
embedded spreadsheets. 

 Your own templates, e.g., 

o IES style reports  

 

o a one-pager for your website 

 

o an extensive report for R&D purposes 

 

o special reports for TM30-18, Medi-Lux, Flicker, Power etc. 

 

o a report especially for indoor luminaires with UGR table etc. 
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o a report especially for outdoor luminaires BUG rating etc. 

In short – the Viso PDF generator is the most versatile light measurement reporting 
tool available, and we hope that you will make use of the capabilities – maybe in 
close cooperation with your marketing department. 

In this way, your professional light measurement results can hopefully get a reach 
that goes far beyond the lab. 

2. Settings 

2.1. Units and regional settings 
Regional settings are important for choice of photometric/radiometric and 
dimension units and for decimal separators.  Settings are generally inherited down 
through this hierarchy – meaning that you can override on every level except the 
top/default level:  

1. Default software settings 

2. Your application settings 

3. Your export settings for all 
 templates 

4. Your settings for a specific export  
template 

5. Your settings for specific keywords  
and graphics within a template.  

 

The hierarchy is further explained in this window that you will find in  

 

If you make changes you will be able to track them here until level 4 (in example, 
non-standard settings are applied in level 2 and 3.): 
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2.2. Changing the logo 
Per default, all report templates carry a Viso logo.  

These logos are all placeholders that can be automatically replaced with your own 
logo. Add your own logo as an image file (.jpg, .png, .svg or PDF).  

 

Once loaded, the window will look like this: 

 

You can now also remove the logo (automatically going back to the default Viso logo) 
or replace with another logo (“change logo”). 

2.3. Image export 
All graphics in your reports can be exported as separate .png files whenever you run 
the run the template. Such bit maps could be used in e.g. your own product 
datasheets or on your website. 
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If you want this to happen every time, tick the “Save graphics” and pick a resolution. 

 

3. Using templates to make PDF reports 
Once you have made a Light measurement, click on File → Export →  PDF. 

 
In this window, you will see a browser that allows you to select a PDF report 
template. A set demo templates are part of your software installation.  

To generate a report, simply pick a template and click Preview or Save. 

3.1. The toolbar 

Template tools 

 

Create a new PDF template from scratch. Read more in section 0,  
Getting started making your own customized PDF report template 
designs. 
 

 

Use this button to delete a template. 
 

 

Use this button to copy a template (save a copy under a new name) 
Advice 

It is possible to have several 
templates open at the same time 
and copy content from one to 
another 
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Use this button to edit an existing template.  
It is possible to have several templates open at the same time and copy 
content from one to another (works if templates are opened from Light 
Inspector). 

 

Use this button to open the PDF toolbox – read more in section 0. 

 

See section 2, Settings: 
Click this button to  
• Change regional settings 
• Add a standard logo to your reports (will be effective when using 

the “Logo” image from the toolbox). 
• Automate exporting all generated graphics into a special folder for 

each PDF file. This is useful if the graphics are to be used e.g., in 
marketing materials or on a website. 

PDF tools 

 

Use this tool to preview your PDF report 

 

Use this tool to save your PDF report. Will also open the PDF file. 

Template browser tools 

 
Sorting tool 

 
Online template (access to Viso online template will be added later). 

 
Add a folder 
 

 
Open the Report Templates folder in MS File Explorer 
 

 
Refresh the window contents 
 

 
General information about the new template browser. 
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4. Getting started making your own customized 
PDF report template designs 

You can use the built-in templates as they are or change them to fit your purposes 
and save them under a new name. 

You can also create a new template from scratch and use the elements in the 
toolbox to populate your special template with your selection of content. 

The small template logos indicate compatible types: 

 

VREP format (extension .vrep) No requirements 

 

Rich text format (extension .rtf) or MS 
Word format (extension .docx) 

Requires Microsoft 
Office installation 

 

Open Document/Libre Office document 
(extension .odt) 

Requires a Libre Office 
installation 

It is recommended to use the VREP format, as this format works much faster than 
the other two, that requires office software to open in the background). 

It is also possible to export to a predesigned PDF report background, where Light 
Inspector just “fills in” specific plots and data. This particularly interesting if you want 
to reuse data sheet designs or have datasheet designs from other software: 

 

VREP format with PDF background design No requirements 

 

When you click “New”, you get to choose between the following formats: 

 

Pick any of the above and click ‘ok’, then save under a new name and/or a new 
folder. 

4.1. Saving templates 
When saving a template generated within Viso software, it is automatically saved in 
a subfolder of your standard measurements folder. The default folder is:  
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C:\Users\’YourUserName’\Documents\Viso Systems\Light Inspector\Report 
Templates 

Look in Setup → Options → Tab: Basic to see what your current setting is. 

Within the Report Templates folder there is just one subfolder when you start using 
the system: The Standard Templates folder. You can make more folders if you wish. 

If your standard measurements folder is a shared folder, your PDF templates are 
automatically shared too. 

If you receive other templates from Viso Systems, save them in the above structure 
to make them available. 
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5. About keywords and graphics 
You may write reports in any language and add your own design elements, logo, 
colors, fonts, page formats etc. 

In general, your specific measurements data will be extracted from your 
measurement results and presented in reports by means of: 

• {KEYWORDS} – special code in “curly” brackets = braces, and 

• Standard graphical elements. While you are designing your template, 
these elements contain “placeholder” graphics. When you use the 
template to generate actual reports, the graphics will be replaced with 
your results as vector graphics. All graphics can be resized while remaining 
crisp and clear. 

Your own selection of both types can be placed anywhere in a report and can be 
combined with your own texts in any language. 

This makes designing your own reports super flexible. There are more than 200 
keywords, and 60 standard graphical elements exist in the Template toolbox.  

Use the search field to find the specific keywords that you need.  

 

Tip 

Keywords can extract data 
without or with units. All units 
setting are available when you 
right-click on the keyword and 
pick “Properties”.  

Tip 

Customize graphics, as e.g. the 
mounting height in an iso-lux 
diagram.  

Right-click on the diagram and 
pick “Properties”. 
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Missing a keyword? Contact Viso Systems on info@visosystems.com, or calculate 
your special results or checks automatically within the report, see page 21, Using 
tables for small calculations 

5.1. Using demo data while editing a template 
You will notice that many keywords are replaced with demo data while the VREP 
editor is running so that you can verify that the data extraction, calculations, number 
of decimals, etc., are functioning properly.  

It is also possible to use the open measurement as input, when building a template. 
Click “viewing demo”: 

 

5.2. Attributes to keywords 
Some keywords are flexible in the sense that certain attributes can be added to 
specify the functionality. The possible attributes are normally specified in the 
toolbox. 

Example {LUM#} 

• Use {LUM} (without the #) to get the overall lumen package of the light 
source 

• Use {LUM90] to get the lumen package in a 90-degree cone 

• Use {LUM45-90} to the lumen package in a zone between the 45-to-90-
degree cones. 

mailto:info@visosystems.com
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• Decimals:  
In .rft, and .dox templates, use {LUM/0.0000} to get the overall lumen 
package of the light source with four decimals  
In VREP use “properties” 

Examples {CIEx#}  

• Use {CIEx} to get the CIE x coordinate pertaining to the overall integrated 
spectrum  

• Use {CIEx45-15} to the CIE x coordinate pertaining to a specific 
measurement angle – here C-plane 45, gamma angle 15. 

Example {CONRES#} 

• Use {CONRES-Intensity-2-4} to get the intensity in candela in a specific 
control setting (Cell 2,4 in the control matrix).  

• Use {CONRES-Intensity-2-4 @W/sr} to get the same result but in unit W/sr 
instead of cd. 

5.3. Attributes to graphics  
Some graphics allow you to make small or extensive customizations, such as scaling 
and rotation of isolux diagrams, choice of units, colors etc.  

In VREP: The method is working with “properties” 

In .rtf/.docx: The method is adding certain keywords to specify the desired behavior 
through Alt Text.  

Changing graphics in VREP 

The possible keyword attributes are normally specified in the toolbox when you click 
on the graphical element. Examples: 

 The Iso-Illuminance plot can be customized in several ways, such as 
mounting height, plot dimensions and plot isolux curves. 

 Angular distribution plots normally just show two sets of curves: Plane C0-
C180 in red and Plane C90-C270 in blue. Adding the keyword 
SHOWPEAKPLANE adds a third, green curve to the plot: The plane in which 
the peak intensity occurs. This is especially applicable in streetlighting. 

Example – using VREP editor:  
Changing the mounting height in an Isolux diagram 

 Insert the diagram, e.g. an Isolux diagram  

 Right-click on the diagram, and pick 
“properties” 
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 Deselect “Use default”, and find mounting height in the settings 

 

 Change to the desired height. 

Example – using Microsoft Word:  
Changing the mounting height in an Isolux diagram 

 Insert the diagram, e.g. an Isolux diagram   

 Wrap the graphics “in front of text” (right-
click → Wrap Text → In Front of Text) 

 Right-click on the diagram and pick 
View_Alt_Text. Then replace the default 
text in the frame with {MOUNTHEIGHT10} to change the mounting height 
from 3 m (default) to 10 m. 

 More keywords can be added in the Alt Text in the same way. 

  

Tip: 

If you make report templates 
using Microsoft Word, graphical 
elements need to be wrapped in 
front of text” to work. 
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6. Making reports with Viso Report Designer 
(VREP) 

This powerful tool allows you to fully customize your report design to facilitate your 
corporate identity and to create your special report templates. This tool also makes 
it possible to show selected measurement data, that are essential for your type of 
product. 

The Light Inspector is the first software to fully give you the power over your 
reporting, reducing the workflow as lighting fixture data sheets can go directly from 
light measurement to the website without the need for marketing post design. 

6.1. Two ways 
There are two ways to start creating your own customized report.  

 Edit one of the preinstalled templates, or  

 Create your own from a blank template.  

All templates are stored in your preferred measurement folder, usually 
C:\Users\’UserName’\Documents\Viso Systems\Light Inspector. The folder Is defined 
in Setup →   Options → Tab: Basic. 

6.2. Starting from a blank sheet 

Building a new custom template 

Click ‘New’ and save your new report under a new name (Default “New Template”). 
Then your Viso Report Designer opens. 

Start by picking a suitable page format: Go to tab: Layout, Click Page Size Presets: 
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It is also possible to make a custom size by defining the Height and Width manually 
(unit = points). 

Then insert a header and a footer that will fill the tops and bottom of all pages 
automatically. In tab Layout, click header →  Edit: 

         →    

Then click ‘Yes’ to insert a default header or no to design your own header/footer 
from scratch. You will find that Viso Report Designer allows you to do many of the 
things that you are used to doing in other office products. You will also find that it 
resembles other layout editors like PowerPoint more than it resembles Microsoft 
Word. 

 

 Gridlines help you to align report elements. 

 Text can be added in separate text boxes 

 Standard graphics can be added (from the toolbox) 

 Standard shapes + your special bitmaps and PDFs can be added 

 Tables can be added as separate table elements; however, tables can also 
work as basic spreadsheets and contain basic functions/calculations. 

 You can embed more complicated calculations and special graphics by 
embedding spreadsheets (LibreOffice or MS Excel). 

 Many elements can be formatted in terms of color and edges.  

The Viso Report Designer tools  

 

Upper right-hand corner 
Use the Zoom button arrow to zoom in or out. 
Alternatively, use CTRL + mouse scroll wheel 
Use the ‘Show grid lines’ button to turn the 
grid on/off 

 

Upper left-hand corner 

Use the save button   to quickly save your 
changes. 

Tip: 

 Use the Preview often when 
designing a new template. What 
you see is not always completely 
what you get. 
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Use the arrow buttons  and  to undo/redo 
actions. Alternatively, use CTRL+z to undo 
most actions. 

 
 
 
 

 

File tab /Report: 
• Use  New  to create a new template 
• Use  Open  to open an existing template 
• Use  Save  to save quickly save your 

changes to the same file.  
Alternatively, use CTRL+s to save 

• Use  Save as  to save your template 
under a new name.  

File tab /PDF 
• Use  Preview  to open preview your 

report results in your standard PDF 
viewer without saving 

• Use  Save  to save and view your result. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 

Layout tab/ Page size 
• Use the  Presets  button to choose 

between 6 standard page sizes (A3, A4, 
A5, Tabloid, Legal and Letter). 

• Make custom page sizes using  Height  
and 
  Width  point counters (example, A4 
paper size in points is 595 x 842).  

Layout tab/ Grid lines 
• Use the  Show  button to turn the grid 

on/off 
• Use the up-down control to customize 

the grid 
Layout tab/ Header/Footer 
• Click the  Edit  button to change the 

header/footer. When there is no header, 
the Designer will ask whether you would 
like to load a default header/footer: 

 
• Click the  Remove  button to delete the 

header/footer. 
Design Backdrop 
If you already have a report design that you 
want to use it is possible to use VREP just to 
fill certain data fields or areas that should 
contain graphics. 
Import a “Design backdrop” as a single or 
multipage PDF. This backdrop will be layered 
behind the VREP contents much like a 
watermark would be. 
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NOTE: All new elements are inserted in the 
middle of your view. When inserting, a new 
tab with relevant setting appear. 
 
Insert tab/ Page 
• Use the  Add page  button to insert a 

page after the one that you are working 
on 

Insert tab/ Shape  
• Use the  Shape  button to insert basic 

shape (line, rectangle or ellipse). The 
default insertion point is the upper left-
hand corner. Move and scale and 
reshape with mouse keys. 
Add colored borders and fill. Set aspect 
ratio as size (in points).  

Insert tab/ Text 
• Use the  Textbox  button to insert a basic 

text field. The default insertion point is 
the upper left-hand corner. Move and 
scale and reshape with mouse keys. 
Read more in page 19, Text boxes. 

Insert tab/ Table 
• Use the  Table  button to insert basic 

table and configure: 

 
The default insertion point is the upper 
left-hand corner. Move and scale and 
reshape with mouse keys. 
Read more in page 19, The color picker 

 

Insert tab/ Import 
• To insert a picture (photo, graphics, logo 

etc.), click  Picture  
• To insert an embedded spreadsheet, click 

 Excel  or  ODS . Read more in page 25,  
• Inserting spreadsheets as embedded 

objects. 
• To insert a PDF file, click  PDF . 

 

Insert tab/ Keyword 
Keywords are special codes that will be 
replaced with data when you use the 
template to generate specific measurement 
reports. Keywords are always in “curly” 
brackets (braces), like e.g. the keyword {PWR} 
that will extract the power consumption in 
Watt. 
 
Read more about keywords on page 11,  
About keywords and graphics. 
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Insert tab/ Measurement graphic 
Measurement graphics are standard graphical 
elements that will represent data when you 
use the template to generate specific 
measurement reports.  
 
Read more about keywords on page 11,  
About keywords and graphics. 

 

6.3. Text boxes 
When a text box is inserted, a contextual menu tab appears: 

 

In text boxes, you can do many of the things you expect from a text editor (but not 
all that commercial office software can do). 

You can set the position and size of the text box (turn on the grid to facilitate 
positioning on the page). 

You can use your own selection of fonts, font sizes, colors, accentuations (but just 
one font/size/color/accent per text box). The same goes for alignments and 
decimals. 

You can add a border and a text box fill. You can add border corner radius, and 
transparency (but just one setting per text box). 

6.4. The color picker 
The color picker is the same for many functions: 
 

 

This is the  
present color 

Click here to  
remove color 

These are 
standard color 
swatches 

These are colors 
that you previously 
used 

…or set opaque 
color as 

RGB 

HEX 

HSV  

Pick opaque color 
and saturation 
freely in the circle… 

Tip:  
Instead of using text boxes with 
several lines, use tables and table 
columns to organize information 
on your page. 

 

 Tip:  
You can broadly use your mouse 
for editing: Starting from an 
empty space in the report, mark-
up an area over the elements that 
you want to edit. Right-click to get 
your options. 

This also work for table cells. 

 

 

 

       
    

        
    

 

 

Click here to 
change 
transparency 
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6.5. Tables 
In tables, you can organize text and keywords to form nicely adjusted columns and 
rows. 

Initially, you get to add a specific number of rows and columns: 

   Note: Will be inserted in the middle of your view  

To move the whole table: Mouse hover over the table borders until you see this 
icon:  Click, hold and move. 

You can always add or remove rows and columns: 

To add a column/row: Click in a cell to mark it. Then either 1) right-click in the cell 
and pick one of the insert options or 2) use the red insertion direction buttons in the 
table settings menu: 

 

To remove row(s)/column(s): Use your mouse to mark up the row(s)/column(s) that 
you want to remove, right-click in the cells and pick the delete option. 

To adjust the cell width/height: Mouse hover over the table borders until you see 
this icon:  Click, and adjust. Or click in a cell and use table setting menu to adjust. 

Change cell settings 

 

Use these tools to change the cell dimensions (affects the whole row and column) 
and to add or remove borders.  

 

Formatting tables 

• Click inside a call to format this cell specifically 

• Click and hold to drag an area covering a group of cells that you want to 
format. Start in an empty area on the page. 

• You can add borders to your cells – but only one border type per cell (in 
conflicts, the border applied most recently will take precedence).  
Per default, all tables have light grey borders when you insert them. These 
borders will be visible in your reports unless you actively remove them 
(make them transparent or white). 

• You can add fill (opaque or transparent) to your cells. 

Tip:  
You can one apply one border 
style (color, thickness, etc. to a 
cell. So e.eg. different top an 
bottom borders are not an option. 

Overlayer another table to make 
more styling. 

Overlayer with a text box, if you 
want to make text across two cells 
or more 
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• You can use individual fonts, colors, fort sizes, and alignment in each cell or 
groups of cells. 

• Work with table placement and size: 

 
With the Crop functionality, you can hide intermediate data calculation 
fields in the final view. 

• You can set the quantity of decimals directly in the table menu:   
or click  to get more options: 

 
 

Using tables for small calculations 

In VREP, tables are great for organizing text elements, but can also be used for 
calculations: 

If you type “=” in a cell, the whole table automatically changes to look more like a 
spreadsheet: 
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Get an overview of the available functions by click the  button.  

 

Use {KEYWORDS}, standard operators and functions to create calculated results: 

 

This example calculates the flux value in lumen per meter, which is valuable for LED 
strips.  

You will see demo results (based on an arbitrary measurement file) building on the 
fly, so that you can check functionality. 

 

Remember that “,” is decimal separator, and “;” separates arguments in a function. 

You can also use logical expressions, for example to check for compliance: 

Examples: 

=IF({SDCM}<3;"Compliant";"Non-compliant") 
=IF({B_ANG}<50;"Narrow beam";"Wide beam") 

Available functions: 

 Group Description Syntax 

 Logical 

 AND  Logical ‘and’. Returns TRUE if all of its arguments are 
TRUE 

 

 OR  Logical ‘or’, Returns TRUE if any argument is TRUE  

 IF  Logical ‘if’ - Specifies a logical test to perform =IF(C2=”Yes”;1,2) 
In the above example, cell D2 says: =IF(C2 = Yes; 
then return a 1; otherwise return a 2) 

 NOT  Reverses the logic of its argument  

 FALSE  Returns the logical value FALSE =FALSE() 

 TRUE  Returns the logical value TRUE =TRUE() 

 >, <,  
>=, <= 

Larger than, Less than 
Larger than or equal to, Less than or equal to 

 

 Text 



 
 

 

 
 23 

 

 Group Description Syntax 

 CHAR  Returns a special character specified by a number from a 
standard character set as, e.g. ANSI 

=CHAR(number) 
α Greek small letter alfa =CHAR(945) 
β Greek small letter betas =CHAR(946) 
γ Greek small letter gamma =CHAR(947) 
μ Greek small letter mju =CHAR(956) 
° Degree sign =CHAR(176) 

 CONCATENATE Use CONCATENATE, to join two or more text strings into 
one string. 

Syntax: CONCATENATE(text1; [text2]; ...) 

 CODE Returns a numeric that corresponds to the character set 
used by your computer. 

=CODE(text) 

 LEN LEN returns the number of characters in a text string =LEN(text) 

 FIND FIND locates one text string within a second text string 
and return the number of the starting position. 

=FIND(find_text; within_text; [start_num]) 

 Numerical 

 ABS   Returns the absolute value of a number =ABS(number) 

 CEILING  Returns number rounded up, away from zero, to the 
nearest multiple of significance 

=CEILING(number; significance) 

 FLOOR  The FLOOR function in Excel rounds a specified number 
down to the nearest specified multiple of significance 

=FLOOR(number; significance) 

 SIGN  Determines the sign of a number. Returns 1 if the number 
is positive, zero (0) if the number is 0, and -1 if the 
number is negative 

=SIGN(number) 

 TRUNC  Truncates a number to an integer by removing the 
fractional part of the number 

=TRUNC(number; [num_digits]) 

 INT Rounds a number down to the nearest integer = INT(number) 

 SUM Adds values =SUM(number1;[number2];...) 

 AVERAGE  Returns the average (arithmetic mean) of the arguments =AVERAGE(number1; [number2]; ...) 

 AVERAGEA  Calculates the average (arithmetic mean) of the values in 
the list of arguments. 

=AVERAGEA(value1; [value2]; ...) 

 MIN  Returns the smallest value in a set of values =MIN(number1; [number2]; ...) 

 MAX  Returns the largest value in a set of values =MAX(number1; [number2]; ...) 

 Information 

 COUNT  The COUNT function counts the number of cells that 
contain numbers, and counts numbers within the list of 
argument 

=COUNT(value1; [value2]; ...) 

 COUNTA  The COUNTA function counts the number of cells that are 
not empty in a range 

=COUNTA(value1; [value2]; ...) 

 COUNTBLANK  Counts the number of empty cells in a range of cells =COUNTBLANK(range) 

 COUNTIF  Counts the number of cells that meet a criterion =COUNTIF(Where do you want to look?; What do 
you want to look for?) 
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 Group Description Syntax 

For example: 
=COUNTIF(A2:A5;"London") 
=COUNTIF(A2:A5;A4) 

 Trigonometric (angles are specified in radians) 

 COS  Returns the cosine of the given angle. =COS(number) 

 COSH  Returns the hyperbolic cosine of a number =COSH(number) 

 ACOS  Returns the arccosine, or inverse cosine, of a number. The 
returned angle is in range 0 (zero) to pi 

=ACOS(number) 

 SIN  Returns the sine of the given angle. =SIN(number) 

 SINH  Returns the hyperbolic cosine of a number =SINH(number) 

 ASIN  Returns the arcsine, or inverse cosine, of a number. The 
returned angle is in range 0 (zero) to pi 

=ASIN(number) 

 TAN  Returns the tangent of the given angle =TAN(number) 

 TANH  Returns the hyperbolic tangent of a number. =TANH(number) 

 ATAN  Returns the arctangent, or inverse tangent, of a number. 
The returned angle is given in radians in the range -pi/2 to 
pi/2 

=ATAN(number) 

 ATAN2  Returns the arctangent, or inverse tangent, of the 
specified x- and y-coordinates. The angle is given in 
radians between -pi and pi, excluding -pi 

=ATAN2(x_num; y_num) 

 Exponential/logarithmic 

 EXP  Returns e raised to the power of number =EXP(number) 

 POWER  Returns the result of a number raised to a power =POWER(number, power) 

 SQRT  Returns a positive square root =SQRT(number) 

 LN Returns the natural logarithm of a number. =LN(number) 

 LOG Returns the logarithm of a number to the base you specify =LOG(number, [base]) 

 LOG10 Returns the base-10 logarithm of a number =LOG10(number) 
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7. Inserting spreadsheets as embedded objects 
In all file types, you can embed excel spreadsheets, work with algorithms and custom 
graphics.  

In this way you can: 

• Make large data extractions on separate underlying sheets. 

• Work with this data in all of the ways that LibreOffice or Microsoft Excel 
permits, including specialized graphics and advanced functions. 

• Choose what you want to present in the PDF report – only the front sheet 
of spreadsheet will be visible when embedded in your report template. 

Contact Viso Systems info@visosystems.com to get more advice and inspiration. 

  

mailto:info@visosystems.com
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8. Inserting photos and other graphics 

Images from your measurement file 

Images being part of your .fixture file (inserted with this function):

 
can be entered as a standard graphical element via the Toolbox graphics. 
If there is more than one image, they can be called individually:  

 Drag-and-drop as many “Product Photo” images from the Toolbox to the 
.rft file as needed. 

 Right-click each image and add alternative through the “Edit Alt Text...” 
command. Add keyword {PIC1} to the Alt Text of the first image, {PIC2} to 
the Alt Text of the second image and so on. The general keyword {PIC#}. 

 In MS Office: Make sure that that all image wrappings are set to be in front 
of the text  

Other pictures 

You can insert other fixed images with extensions .jgp, .png or .bmp in your 
templates. This could for instance be a line drawing of your product. 

 

You can also insert a PDF file.  

Such a PDF file could constitute an empty template itself, which you may overlayer 
with data extracted from your measurements. 
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9. Other templates 
Download PDF report templates (format .rtf) from Viso’s website as plug-ins 

In https://www.visosystems.com/download-plugins/ you can download Viso plugins 
for the Light Inspector software. 

Plugin features 

 Compatible with Viso Light Inspector 

 Contains .rtf-files (edit in MS Word) 

 Download is free 

 Plugin allows you to build your own PDF output templates 

Download instructions 

 Press the download button for the template you need 

 Once the template is downloaded, go to your “Download” folder and 
double click on the file 

 Now, the template will automatically be added to your templates 
collection in your dedicated measurements folder (usually 
C:/Users/’YourUserName’/Documents/Viso Systems/Light Inspector/). The 
template is available as a PDF template in the PDF report generator in the 
Light Inspector software. 

Customizing the templates 

As with other Viso templates, you may also change all plug-in templates for your 
own purposes. The templates are all .rtf (rich text format) files that can be altered in 
MS Word. The templates are organized as sections that you may use separately or 
collect into your own master templates: 

 Open the Main template (contains overall measurement conditions and 
results) 

 Open the template with contents that you want to add. Press Ctrl+A, then 
Ctrl+C. Now, all contents are copied to your clipboard 

 Revert to the Main template. Press Crtl+End, then Ctrl+V. Now the full 
contents of the other template have been added 

 Save the template under a new name in your standard measurements 
folder (format: .rtf or .docx file). 

  

https://www.visosystems.com/download-plugins/
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10. Making .dox, .rtf, and .odt templates 

11. Exporting Several PDF Files at Once 
Light Inspector can export several measurement files at once, simply hold CTRL down 
and select the files you want to export and go to File – Export and choose the format 
you want. Then click ‘Save PDF’.  

12. Exporting standard graphics and PNG files 
It is possible to export all standard graphics related to a specific PDF report to 
separate PNG files. 

 

When you generate the PDF report, the images and your PDF report will be stored in 
the same location – the images in a new folder, that will have the same name as your 
PDF report + “images”: 

 

Exporting graphics does not work for “Fixed” report templates.



 
 

 
  

 

At Viso Systems we design, develop and manufacture OEM- and customer-specific 
goniophotometer solutions. Our mission is to support customers with powerful and 
yet easy to use control measurements solutions. Products are developed and 
manufactured in Copenhagen, Denmark. 
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